Guidelines for the Preparation of
Theses, Doctoral Projects, Dissertations,
and Journal Article(s)

2018 – 2019

Theses/Doctoral Projects/Dissertations/Journal Article(s) are capstone experiences for
graduate students at CMU. Graduate students at CMU who must submit a thesis/doctoral
project/dissertation/journal article(s) as part of their degree requirements must comply
with the university’s guidelines for the preparation of such documents. These guidelines
outline the thesis/doctoral project/dissertation/journal article(s) requirements established
by the Graduate Committee and College of Graduate Studies. The guidelines and forms
referred to in this guide take precedence over previous publications issued by the College
of Graduate Studies.
2018-2019
Thesis/Doctoral Project/Dissertation/Journal Article(s) Deadlines

What is Due
Graduation Application Deadlines*

All defended, committee-approved
theses/doctoral
projects/dissertations/journal article(s) and
required documents must be submitted by
5:00 p.m. EST**

Graduation Date
December
May
August
2018
2019
2019
April 1

October 1

February 1

October 15

February 25

June 10

*Students must apply for graduation, even if they will not participate in commencement
ceremonies. Applying for graduation generates an audit of the student’s academic file
and notifies the university that the student intends to graduate.
**The College of Graduate Studies does not begin reviewing documents for the new
graduation cycle until one month after the current graduation cycle closing date. For
example, review of August graduation theses/doctoral projects/dissertations/journal
article(s) does not begin until June 1st, approximately one month after May
commencement exercises. Allow 14 business days for the initial document review by the
College of Graduate Studies. Students who will not be on campus should plan
accordingly.

Before Undertaking Your Project
Committee Chairperson & Committee Selection and Graduate Faculty Status
Students should consult their academic advisor in selecting a committee chairperson and
at least two committee members. Academic advisors may or may not be the committee
chairperson. One committee member may be from a discipline other than the student’s
area of concentration OR a non-CMU faculty member.
For theses/doctoral projects/dissertations/journal article(s) completed through Central
Michigan University's Global Campus, one of the three committee members must be a
CMU main campus regular faculty member or a regular faculty member from a
collaborating university (such as in a joint program), or if all committee members are from
Global Campus, the committee chair must meet the requirements for regular graduate
faculty status as defined by the Academic Senate's Graduate Education Policy and be
approved as committee chair by the department.
Graduate students must ensure all committee members possess graduate faculty status.
Contact the College of Graduate Studies (989-774-1318) to verify a committee member’s
status. Graduate Faculty applications are available on the Graduate Studies website
under the Faculty & Staff tab.
Human and Animal Experimentation and Recombinant DNA
Limitations exist regarding human, animal, and recombinant DNA experimentation.
Before filing the Prospectus and beginning any research, students developing
theses/doctoral projects/dissertations/journal article(s) with research involving those
groups require approval from the appropriate committee before the research begins.
Contact the Office of Research Compliance for assistance (989-774-1152).
 Human Subjects: Institutional Review Board (IRB)
 Animals: Institutional Animal Care & Use Committee (IACUC)
 Recombinant DNA: Institutional Biosafety Committee (IBC)
Prospectus
Master’s students may not enroll for more than three thesis credits and work on the project
may not begin until the project has been approved by the appropriate research review
board (if applicable) AND the Prospectus has been approved by the committee chair and
members, the department chairperson, AND by the Dean of the College of Graduate
Studies. Doctoral students may not enroll for more than six dissertation credits and work
on the project may not begin until the prospectus is fully approved. Projects must not be
undertaken until the form is approved by the Dean of the College of Graduate Studies.
Projects undertaken prior to the Dean of the College of Graduate Studies approving the
Prospectus and prior to appropriate review board approval may be denied and the project
deemed invalid.

Preparing for the Defense
In conjunction with the committee chair, students should review the thesis/doctoral
project/ dissertation/journal article(s) deadlines for the semester in which the student
wishes to graduate. Students should give committee members ample time to thoroughly
review the draft while keeping in mind the deadline for submitting the final, defended,
committee-approved document to the College of Graduate Studies for review. The
College of Graduate Studies does not need to be notified of your oral defense in advance.
Present to the committee for final review a finished document of professional quality and
free of errors. Following the defense, the student should work with committee chair and
members to rectify any changes they want made to the draft PRIOR to submission to
the College of Graduate Studies.

Required Forms/Applications
The forms listed below are required by the College of Graduate Studies in the timeframe
indicated. Failure to submit these forms on time may result in having to apply for the next
graduation cycle. All forms are available on the College of Graduate Studies website
(www.grad.cmich.edu).
Prospectus – Theses, Doctoral Projects, Dissertations, and Journal Article(s)
 Students may not enroll for more than three thesis/dissertation credits and work
on the project may not begin until the project has been approved by the
appropriate research review board (if applicable) AND the Prospectus has been
approved by the committee chair and members, the department chairperson,
AND by the Dean of the College of Graduate Studies.
 A two-page, double-spaced synopsis of the project
 Approval memo/letter/email from the appropriate review board (if applicable)
 Submit all of the above items as ONE PDF to cgsthesis@cmich.edu.
Graduation Application
 Students must apply for graduation, even if they do not plan to participate in
commencement. Applying for graduation generates an audit of the student’s
academic file and notifies the university the student intends to graduate.
Students that do not apply for graduation by the second application deadline
must apply for the next graduation cycle in order to graduate.
 Submit online at www.grad.cmich.edu.
For theses/doctoral projects/dissertations/journal article(s) to meet the College of
Graduate Studies submission deadline, the following document must electronically
accompany the student’s final document:
Dissertation/Doctoral Project/Journal Article(s) Completion Sign-Off Form
OR
Plan A Completion Sign-Off form
 Once the student has successfully completed the oral defense of his/her project,
this form is signed by the student’s committee and the department chairperson.
 Submit as a PDF only to cgsthesis@cmich.edu

Document Preparation
The most important facets (and most common errors) of thesis/doctoral
project/dissertation/journal article(s) preparation are in: margins and consistency
throughout the document in wording, appearance, punctuation, and formatting. Paying
close attention to these areas will be beneficial in the long run. Please note that
exceptions are sometimes given. An exception once is not a change in CGS policy.
Content Format Options
Some academic departments/programs allow their students to submit their work in a
journal article(s) format rather than in the traditional thesis/doctoral project/dissertation
format. Graduate students interested in utilizing the journal article(s) format should check
with their department on whether the article format is permissible.
Students & Committees
Students must ensure the document is accurate in content, has been proofread and
edited carefully for correct grammar, and meets the required standards outlined in this
document. Students are responsible for ensuring they are using the most current set of
Guidelines.
Style Manuals
The College of Graduate Studies does not prescribe a particular style, but departments
often do. In many disciplines, a professional manual or journal is acknowledged as the
accepted guide for headings, subheadings, tables, figures, and documentation styles.
The review conducted by the College of Graduate Studies is to ensure that the
thesis/doctoral project/dissertation/journal article(s) meets College of Graduate
Studies/CMU Guidelines not any particular style of formatting (e.g. APA, MLA, etc.).
College of Graduate Studies/CMU requirements may or may not agree with these style
formats. The College of Graduate Studies tries to keep requirements as close to these
style preferences as much as possible, but this may not always be feasible.
Use of a Typist
The service of a typist to produce the final draft of a thesis/doctoral
project/dissertation/journal article(s) is allowed by the College of Graduate Studies.
However, the use of a typist is for formatting purposes only. Using a typist for the purpose
of editing the content of a thesis/doctoral project/dissertation/journal article(s) is strictly
prohibited. All arrangements, including the financial aspect, are handled directly between
the typist and the student. Revisions required by the College of Graduate Studies are
sent directly to the typist. The student and the typist will receive confirmation when the
thesis/doctoral project/dissertation/journal article(s) is finalized.

Submission Process
Documents completed in Microsoft Word ONLY
 Submissions should be emailed to the College of Graduate Studies at
cgsthesis@cmich.edu
 Email subject line should be:
o LAST NAME-type of document-graduation cycle
Example: SMITH-Journal Article-May 2022
 For your submission to be considered, the following forms must accompany your
document. Your thesis/doctoral project/dissertation/journal article(s) is not
reviewed until all forms are received.
o The final, defended, committee-approved thesis/doctoral
project/dissertation/journal article(s) as a Microsoft Word document.
o Dissertation/Doctoral Project/Journal Article(s) Completion Sign-off Form
OR
Plan A Completion Sign-off Form
Documents completed in a format OTHER THAN Microsoft Word (LaTeX)
 Submissions should be emailed as a PDF to the College of Graduate Studies at
cgsthesis@cmich.edu
 Email subject line should be:
o LAST NAME-type of document-graduation cycle
Example: SMITH-Journal Article-May 2022
 For your submission to be considered, the following forms must accompany your
document. Your thesis/doctoral project/dissertation/journal article(s) is not
reviewed until all forms are received.
o The final, defended, committee-approved thesis/doctoral
project/dissertation/journal article(s) as a PDF document.
o Dissertation/Doctoral Project/Journal Article(s) Completion Sign-off Form
OR
Plan A Completion Sign-off Form
Allow 14 business days for the initial document review by the College of Graduate
Studies.

Completion Process
Once the thesis/doctoral project/dissertation/journal article(s) has been approved by the
College of Graduate Studies, the College will save the document as a PDF, and forward
it to the Park Library for uploading into the University’s Digital Collections. At that time the
thesis/doctoral project/dissertation/journal article(s) requirement will be removed from the
student’s graduation audit. The Park Library will ONLY accept items for Digital
Collections uploading from the College of Graduate Studies.
Theses/doctoral
projects/dissertations submitted to the Park Library by students or committee chairs will
not be accepted. Please note: The Digital Collections is a publicly available repository.
This means your thesis/doctoral project/dissertation/journal article(s) will be available to
people within CMU as well as outside of CMU and will be visible through search engines
such as Google. If you would like to delay the uploading of your document to the Digital
Collections for 12 months because of conflict with a potential patent or publishing please
check that box on your Dissertation/Doctoral Project/Journal Article(s) Completion Signoff Form or Plan A Completion Sign-off Form.
It is the responsibility of the graduate student to check with his/her department to verify if
their department requires a bound copy, microfilming, or uploading to ProQuest. Students
should follow their department’s directions.
Students are responsible for keeping a copy of their final thesis/doctoral
project/dissertation/journal article(s). The College of Graduate Studies does not retain
copies.

Thesis, Doctoral Project, or Dissertation
Document Requirements
Typeface
 Acceptable fonts: Arial or Times New Roman
 Font size (including tables and figures): 10 point or 12 point font (be consistent)
Margins
 All Margins: 1.0 inch
Spacing
 All general text is double-spaced unless noted
 Before a heading there should be extra space. Extra spacing = two blank singlespaced lines and begin typing the subheading on the third line.
 No extra space between paragraphs or after a subheading
 Each major section or chapter must start on a new page
 New paragraphs should be indented 0.5 inches from the left margin
 Table text should be single-spaced
 References can be single or double-spaced. Be consistent. Entries do not cross
pages.
 Numbered/Bulleted/Lettered Series/Block Quotations
o Indented from the left or both the left and right margins
o Text can be single or double-spaced
Headings
 Before a heading there should be extra space. Extra spacing = two blank singlespaced lines and begin typing the subheading on the third line.
 The principal words in a heading should be capitalized
 Recommended formatting for headings:
o 1st Level Headings: centered, no bold, no italics
o 2nd Level Headings: left-aligned, no bold, italics
Pagination
 Bottom Center is the only acceptable place for ALL page numbers (even on
landscape pages)
 Preliminary pages:
o Lower case Roman numerals (title page is not numbered)
o Begin page numbers on the page following the title page with number “ii”
 Text, Appendix, Bibliography pages:
o Arabic numerals
o Begin on the first page of Chapter I with page number “1”
 Pages numbers do not appear below the bottom margin. The bottom margin
indicates the space below the page number.
Section Order





Preliminary pages:
o Title page
o Frontispiece (optional)
o Copyright (optional)
o Dedication (optional)
o Acknowledgments (optional)
o Abstract
o Table of Contents
o List of Tables (two or more)
o List of Figures (two or more)
o Keys to Symbols, Definitions, Abbreviations, etc (optional)
Text and Supplementary pages:
o Document text
o Appendix/Appendices (if applicable)
o Appendices always precede Bibliographies, whether within a chapter or at
the end of the document
o Bibliography/References/Literature Cited, etc.

Tables and Figures
 Must be embedded as near as possible to where they are referred to in the text
they illustrate NOT at the end of the chapter or in the appendices
 Only refer to Tables and Figures within the text not within the appendices
 The principal words in the Table/Figure titles should be capitalized
Appendix/Appendices (if applicable)
Appendices are used to contain supplementary illustrative materials, original data, or
material too lengthy for inclusion in the text or not immediately essential to an
understanding of the text.
 Examples: supplementary illustrative materials, original data, mathematical
derivations, computer programs, and subject letters
 Tables and Figures within the appendices are not contained in the List of Tables
or List of Figures
 Appendices ALWAYS follow the final page of text and are numbered
consecutively whether within a chapter or at the end of the document
o If there is only one appendix, that page should be numbered to
immediately follow the last page of text. For example, if the last page of
the text is numbered "127," then the first page of the appendix is number
"128."
o If there is more than one appendix, the page immediately following the text
should read “APPENDICES” centered in the middle of the page. This
page should be numbered to immediately follow the last page of the text.
For example, if the last page of the text is numbered "127," then the first
page of the appendices is number "128."

Bibliography/References/Literature Cited
 Format acceptable to discipline is utilized and used consistently
Footnote/Endnotes (if applicable)
 Format acceptable to discipline is used consistently throughout the document
 Single-space multi-line entries
 All footnotes must conform to margin requirements

Journal Article(s) Document Requirements
Typeface
 Acceptable fonts: Arial or Times New Roman
 Font size (including tables and figures): 10 point or 12 point font (be consistent)
Margins
 All Margins: 1.0 inch
Spacing
 As required by journal, be consistent
Pagination
 Bottom Center is the only acceptable place for ALL page numbers (even on
landscape pages)
 Pages numbers do not appear below the bottom margin. The bottom margin
indicates the space below the page number.
Journal Article(s) order
 Should follow the format for your journal. However, there should be a preliminary
page section that follows CMU guidelines.
 Preliminary Pages:
o Title Page
o Frontispiece (optional)
o Copyright (optional)
o Dedication (optional)
o Acknowledgements (optional)
o Abstract
o Table of Contents
o List of Tables (two or more)
o List of Figures (two or more)
o Keys to Symbols, Definitions, Abbreviations, etc. (optional)
 An appropriate Bibliography should follow at the end if not stipulated in some
other manner by your journal. You may include a Bibliography after each journal
article if your document consists of more than one journal article.
Footnote/Endnotes (if applicable)
 Format acceptable to discipline is utilized consistently through the document
 Single-space multi-line entries, conform to margin requirements
Please Note
 Please let the reviewer know if they request revisions that are contrary to the
requirements of your journal(s). The College of Graduate Studies tries to be as
flexible as possible with journal article(s) submissions as the formatting
requirements for the journal article(s) will not be known to the reviewer.

TIPS
Ellipsis Marks
 Use ellipsis marks instead of periods for Table of Contents, List of
Tables/Figures, etc.
 Ellipsis marks should continue from the last word of the title to the page number
which should be right aligned.
o On the Home tab click on “Paragraph”
o Click on “Indents and Spacing” tab
o Click on “Tabs” on the bottom left
o Under “Leader” choose the second option which is “…..”
Widow/Orphan Control
 Provides the ability to keep text together so a document does not develop single
words or lines of text at the top or bottom of pages
o On the Home tab click on “Paragraph”
o Click on “Line and Page Breaks” tab
o Under “Pagination” click to select “Widow/Orphan control”
Page Numbers Positioning
 Insert page numbers using the Page Numbers command on the Insert menu.
Then adjust the bottom margin of the footer:
o Double click inside the footer
o On the Header & Footer Tools Design tab adjust spacing in the “Footer
from Bottom” box
Creating Sections
You will need separate sections in your document in order to format your page numbers
different and/or have landscape page(s)
 Place your cursor at the end of the first section; click the “Layout” tab then click
on “Breaks” and select “Next Page” under “Section Breaks”
 Repeat these steps at the end of each section
 Please note: If you do not want the footer of one section to link to the footer of
the previous section you will need to unclick the “Link to Previous” button in the
Header & Footer Tools Design Tab
Change the Vertical Alignment of Text
 On the Layout tab click on “Orientation” and select “Landscape”
 In order to make one or more pages landscape you will need to create a new
section – see earlier tips on how to create sections

EXAMPLE PAGES
The following pages serve to provide examples for your preliminary pages as well as
portions of your text and supplementary pages. You will find notes on each page in
brackets. These brackets should not appear in your document, they are used here only
to highlight helpful comments.
There is also a full Word example/template available for your use at
https://www.cmich.edu/colleges/cgs/current/Pages/Thesis.aspx. If you have further
questions you may contact Kara Owens in the Office of Research and Graduate Studies
at 989-774-1318 or kara.l.owens@cmich.edu.

Title Page Example

TITLE WILL GO HERE TITLE WILL GO HERE TITLE WILL GO HERE TITLE WILL GO
HERE TITLE WILL GO HERE TITLE WILL GO HERE TITLE WILL GO HERE TITLE
WILL GO HERE TITLE WILL GO HERE

Title should be in ALL CAPS

John Smith
Here you will choose one
of the following:
thesis
dissertation
doctoral project
journal article
journal article compilation

A thesis submitted in partial fulfillment of
the requirements for the degree of
Master of Science
This should be your degree:
Master of Arts
Doctor of Philosophy
etc

Department of Biology

This should be the month
and year of your oral
defense

Central Michigan University
Mount Pleasant, Michigan
October 2017

This should be
your department

DO NOT put a page
# on your title page

Copyright Page Example

Copyright by
John Michael Smith
2017

This should be centered on
the page, use your full legal
name and you should use
the year of your oral defense

Page # should start with
“ii” here just above the
1 inch margin

ii

1 inch

Dedication Page Example

This should be centered on
the page and you can write
whatever you like

This is dedicated to my family
for all of their support
throughout this project.
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Acknowledgements Page Example
0.5 inch indent

Should be in ALL CAPS

ACKNOWLEDGEMENTS

I wish to thank the members of my thesis committee: Dr. John Doe, Dr. Jane
Smith, and Dr. Larry Doe. These faculty members provided valuable direction when this
project began, reviewed the draft of the document, and made many contributions to the
final product. Throughout the process, these faculty members drew on their
experiences of working with many graduate students as professors, dissertation
advisors, and dissertation committee members.

This should be one page
maximum and you can write
whatever you like

iv

Abstract Page Example
Should be single spaces

Should be in ALL CAPS

ABSTRACT
TITLE WILL GO HERE TITLE WILL GO HERE TITLE WILL GO HERE TITLE WILL GO
HERE TITLE WILL GO HERE TITLE WILL GO HERE TITLE WILL GO HERE TITLE
WILL GO HERE TITLE WILL GO HERE
0.5 inch indent

by John Smith

The abstract is a very important part of the thesis/doctoral project/dissertation
and should clearly represent the student’s work. Abstract text should be no more than
350 words in length and although there are no sections per se in the abstract, abstracts
should include information that covers the following areas: introduction,
rationale/hypothesis/purpose statement, methodology, results, and conclusion. The
introduction concisely presents the background for the project that was conducted and
outlines the importance of the question being asked. The rationale/ hypothesis/purpose
statement should explain why the project was conducted, and the methodology section
should address how the project was conducted. Finally, the results section describes
the major findings of the student’s work, the conclusions, and what can be drawn from
the findings.
Abstract should be a
maximum of two pages
and should address
items mentioned here

v

Table of Contents Page Example
Should be
right aligned

TABLE OF CONTENTS
LIST OF TABLES ........................................................................................................... vii
LIST OF FIGURES ........................................................................................................ viii
CHAPTER

Should be in ALL CAPS

I.

INTRODUCTION .................................................................................................. 1

II.

METHODS............................................................................................................ 3
Heading A .................................................................................................. 3
Heading B .................................................................................................. 8
Heading 1 ........................................................................................ 8
Heading 2 ........................................................................................ 9
Heading C ................................................................................................ 10
Heading D ................................................................................................ 11
Heading 1 ...................................................................................... 11
Heading 2 ...................................................................................... 12

III.

RESULTS ........................................................................................................... 14
Heading A ................................................................................................ 14
Heading 1 ...................................................................................... 14
Heading 2 ...................................................................................... 16
Heading 3 ...................................................................................... 17
Heading 4 ...................................................................................... 18
Heading B ................................................................................................ 19
Heading C ................................................................................................ 21

IV.

DISCUSSION ..................................................................................................... 23
Heading A ................................................................................................ 23
Heading B ................................................................................................ 27

APPENDICES ............................................................................................................... 28
REFERENCES .............................................................................................................. 31
Only list if there is
more than one
appendix. DO NOT
list appendices
individually.

Heading style, format and
wording should match text
and only list in the Table of
Contents when there are at
least two headings.

vi

Should be ellipsis

List of Tables Page Example

Should be
right aligned

LIST OF TABLES
TABLE

Should be in ALL CAPS

PAGE

1.

CMU Departments Starting with “I” ....................................................................... 4

2.

Student Grants through the Office of Research and Graduate Studies .............. 11

3.

August – October Academic Calendar Deadlines............................................... 24

Should be ellipsis

Table title style, format and
wording should match text.
List of Tables should only be
included when there are two
or more tables. Table titles
that are more than one line
should be single spaced.

vii

List of Figures Page Example

Should be
right aligned

LIST OF FIGURES
Should be in ALL CAPS

FIGURE

PAGE

1.

Central Michigan University Flying C .................................................................... 6

2.

Office of Research & Graduate Studies Logo ..................................................... 19

Should be ellipsis
Figure title style, format and
wording should match text.
List of Figures should only be
included when there are two
or more figures. Figure titles
that are more than one line
should be single spaced.
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Example of Chapter and Heading

CHAPTER I
Should be 1 single space

INTRODUCTION
Should be 2 single spaces

0.5 inch indent

1st level heading – formatting
matches Table of Contents

Heading A

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Vestibulum lacinia mollis
arcu, sit amet tristique nibh maximus pretium. Nulla at nibh mi. Aliquam vulputate
pharetra metus et ultrices. Nunc sed dui neque. Quisque luctus augue odio, in dapibus
nulla suscipit vel. Cras feugiat lobortis lectus, vel tempus ipsum. Aenean et ante id tellus
maximus vehicula. Vestibulum iaculis, leo eget tincidunt facilisis, elit dui pharetra arcu,
eget consequat mi mauris eget libero. Sed et rhoncus nisi. Mauris lacinia, urna et
accumsan posuere, leo ante imperdiet lorem, nec egestas urna ligula eu dui. Mauris vel
orci eget tellus iaculis tempor quis et magna.
Should be 2 single spaces
2nd level heading – formatting
matches Table of Contents

Heading 1

Cras non arcu ac lectus auctor rutrum. Sed ornare lectus justo, ac consequat nisi
finibus ac. Sed tristique ipsum rhoncus facilisis tincidunt. Praesent fringilla felis rutrum,
laoreet ex quis, commodo elit. Sed a turpis hendrerit, pulvinar nisi quis, dignissim elit.
Fusce facilisis sapien id turpis varius, et mollis neque porta. Vivamus fringilla iaculis elit,
sed congue enim egestas sit amet. Sed elit elit, mattis at sem non, sodales fringilla
sapien.
Nullam eleifend sodales fringilla. Vestibulum feugiat neque fermentum, aliquet ex
at, semper nisl. Cras varius purus nunc, vel imperdiet turpis tincidunt quis. Ut sagittis
odio mattis imperdiet faucibus. Praesent at egestas ante, non tristique justo. Vestibulum
Chapter I should start
with “1” here just above
the 1 inch margin

1
1 inch

Example of Table in Text

Donec mi neque, finibus nec mi in, elementum laoreet augue. Praesent mattis
tellus et justo rhoncus, et semper diam eleifend. Integer vel leo sollicitudin, mattis velit
dignissim, mattis sapien. Donec lacinia pharetra metus et hendrerit. Nullam pretium velit
id varius tristique. In facilisis mattis consectetur. Nam venenatis ante nec turpis
commodo, sed efficitur tortor pharetra.
Proin ultrices aliquam eros. Duis et aliquam ligula. Praesent ut nunc nibh.
Maecenas vel elit at nisl sodales cursus. Cras ac ultrices ipsum. Maecenas pretium
fermentum tempus. Mauris at sagittis tellus.
Should be 2 single spaces

Table 1. CMU Departments Starting with “I”
Office Name
Phone Number
Information Technology
989-774-1474
Institute for Great Lakes Research
989-774-4401
Institute for Management Consulting 989-774-1854
Institutional Diversity
989-774-3700
Institutional Research
989-774-3933
Internal Audit
989-774-7082
International Affairs
989-774-4308

Table number and title should
appear above the table with
no space in between the title
and table. Text within table
should be single spaced.
Table should fit within the 1
inch margins. If the table
needs to be landscape make
the page landscape without
any other text on the page
and the page number location
should not change.

Should be 2 single spaces

Donec odio nibh, laoreet vitae pretium eget, dapibus eget turpis. Nulla eget tellus
nisi. Nam pellentesque, mi a tristique pharetra, eros turpis posuere ligula, nec posuere
mauris tellus vel dolor. Nunc quis nulla quis nunc fringilla tincidunt. In tempus ante nunc,
et tincidunt lorem finibus malesuada. Donec euismod ultricies condimentum. In fringilla
aliquet lectus, nec iaculis enim bibendum auctor. Praesent pl acerat odio in nulla
ultrices, quis condimentum ex dapibus. Vivamus rutrum tempor mi. Etiam lacinia libero
justo, ut cursus sapien faucibus sed. Praesent finibus suscipit suscipit. In sit amet
volutpat nunc, in mollis metus. Sed arcu lectus, viverra vel porta id, interdum in turpis.

4

Example of Figure in Text

quis condimentum ex dapibus. Vivamus rutrum tempor mi. Etiam lacinia libero justo, ut
cursus sapien faucibus sed. Praesent finibus suscipit suscipit. In sit amet volutpat nunc,
in mollis metus. Sed arcu lectus, viverra vel porta id, interdum in turpis.
Should be 2 single spaces

Figure 2. Office of Research & Graduate Studies Logo

Figure number and title should appear
below the figure with no space in
between the figure and title. Figure
should fit within the 1 inch margins. If
the figure needs to be landscape
make the page landscape without any
other text on the page and the page
number location should not change.

Should be 2 single spaces

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Vestibulum lacinia mollis
arcu, sit amet tristique nibh maximus pretium. Nulla at nibh mi. Aliquam vulputate
pharetra metus et ultrices. Nunc sed dui neque. Quisque luctus augue odio, in dapibus
nulla suscipit vel. Cras feugiat lobortis lectus, vel tempus ipsum. Aenean et ante id tellus
maximus vehicula. Vestibulum iaculis, leo eget tincidunt facilisis, elit dui pharetra arcu,
eget consequat mi mauris eget libero. Sed et rhoncus nisi. Mauris lacinia, urna et
accumsan posuere, leo ante imperdiet lorem, nec egestas urna ligula eu dui. Mauris vel
orci eget tellus iaculis tempor quis et magna.

Heading B
Cras non arcu ac lectus auctor rutrum. Sed ornare lectus justo, ac consequat nisi
finibus ac. Sed tristique ipsum rhoncus facilisis tincidunt. Praesent fringilla felis rutrum,
laoreet ex quis, commodo elit. Sed a turpis hendrerit, pulvinar nisi quis, dignissim elit.
Fusce facilisis sapien id turpis varius, et mollis neque porta. Vivamus fringilla iaculis elit,
sed congue enim egestas sit amet. Sed elit elit, mattis at sem non, sodales fringilla
sapie
19

Start of Appendices Example

This page should exist only if you
have more than one appendix. It
should be in ALL CAPS and
centered on the page.

APPENDICES

28

Appendix Example

Should be in
ALL CAPS

APPENDIX A

Should be 1 single space

GRADUATE STUDIES DEADLINES

29

Should be 1 single space

Reference Page Example

Should be in
ALL CAPS

REFERENCES
Should be 1 single space
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